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About Hexagon

About Hexagon

Overview

Hexagon is the leading global provider of virtual product development (VPD) tools, including simulation
software and professional services. Hexagon helps companies make money, save time, and reduce costs
associated with designing, testing, producing, and supporting manufactured products.

Hexagon works with thousands of companies worldwide, in hundreds of industries, to develop better
products faster by using information technology, software, and services to enhance and automate the product
design and manufacturing process. Simulating your product performance reduces development costs, time to
market, and warranty costs.

About Virtual Product Development and Adams

You’ve heard it before: manufacturing companies today face intense global competition, demanding
customers, fragmented markets, increasing product complexity, compressed product cycles, price and profit
pressures, strict regulatory and liability environments, systems integration and supply chain issues,
skyrocketing costs of testing and physical prototyping, and on and on...

What you don’t often hear, though, is a strategy for enabling your company to improve your new product
development process to meet these challenges.

Whether you are delivering airplanes, automobiles, ships, biomedical devices, golf clubs or children’s toys to
your customers, Hexagon goal is to help you improve your new product development process, allowing you
to be significantly better at your concept development, design, testing, and production activities through the

application of VPD.

VPD is an environment that uses an integrated combination of both simulation software technology and
traditional techniques to design, test, manufacture, and support products. The result is that cost-effective
designs that meet all performance, safety, durability, and reliability requirements can be brought to market in
less time and for less cost.

Adams, as part of VPD, is focused on enhancing your ability to make better product development decisions,
explore innovative design alternatives, and consistently get the product right. It is the world's most widely
used mechanical system simulation software. It enables you to produce virtual prototypes, realistically
simulating the full-motion behavior of complex mechanical systems on your computers and quickly
analyzing multiple design variations until an optimal design is achieved. This reduces the number of costly
physical prototypes, improves design quality, and dramatically reduces product development time.

Technical Support

For help with installing or using an Hexagon product, contact Hexagon technical support. Our technical
support provides technical assistance on questions related to installation and use of the software. For further
details please see the Technical Support Usage Guide, which is accessible via our support web site.

You can reach Hexagon technical support on the web, by telephone, or e-mail.
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Web

Go to the Hexagon web site at www.hexagon.com, scroll down and click on Services & Training. Here, you
can find a wide variety of support resources including Product Updates, Discussions, Technical Articles, and
Documentation updates.

In addition, we provide several excellent sources of online information:
= SimCompanion: Find solutions to problems in this repository of troubleshooting tips, examples,
and frequently asked questions. To access the SimCompanion, go to:
https://simcompanion.hexagon.com/

= VPD Community: The VPD community is where to go when you are looking for peer support, as
well as technical expertise. Many of our consultants, developers, and technical support staff monitor
the forums. To sign up for the forums, go to Adams Support Home Page.
Then,

e To view the Adams discussions, select Adams from the Forums menu.

%4 HEXAGON Q| @

A ProductUpdates  Forums v Knowledge Support ~  Documentation ~  Training ~  Software Downdoad Center  Students +  Groups

Product(l)

* To view product alerts and company news and events, select Product Updates.

7.4 HEXAGON a |l @5 e

# ProductUpdates Forums +  Knowledpe Support »  Documentation ~  Traning ~  Software Download Center  Students ~  Growps

Phone and Email

For a current list of phone numbers and language based email addresses please visit our support web site.

Training

Hexagon training provides comprehensive training in Virtual Product Development. We offer standard and
customized training courses in the application of CAE tools to solve from basic to complex problems within
any industry. We offer over 100 courses in our state-of-the-art classroom facilities and individual computer
graphics laboratories at training centers throughout the world. All of our courses emphasize hands-on
computer laboratory work to facilitate skills development. We are uniquely positioned to optimize your
investment in design and simulation software tools.


https://simcompanion.hexagon.com/customers/s/topic/0TOa00000005VAdGAM/adams
https://simcompanion.hexagon.com/customers/s/article-list#t=All&sort=relevancy&f:@mscnormalizedarticletype=[News%20%26%20Product%20Updates]
https://simcompanion.hexagon.com/
https://hexagon.com/company/divisions/manufacturing-intelligence/msc-software
https://simcompanion.hexagon.com/customers/s/article/Adams-Support-Home-Page
https://simcompanion.hexagon.com/customers/s/article/support-contact-information-kb8019304
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Our industry experienced expert staff is available to customize our course offerings to meet your unique
training requirements. For the most effective training, we also offer many of our courses at our customer's
facilities.

We specialize in customized training based on our evaluation of your design and simulation processes, which
yields courses that are geared to your business. In addition to traditional instructor-led classes, we also offer
video courses, interactive multimedia training, web-based training, and a specialized instructor's program.

Course Information and Registration

For detailed course descriptions, schedule information, and registration call the Training Specialist at +1 800
426-1066 or visit www.hexagon.com.

Internet Resources

Hexagon (www.Hexagon.com)

Hexagon corporate site with information on the latest events, products and services for the CAD/CAE/CAM
marketplace.


https://hexagon.com/company/divisions/manufacturing-intelligence/msc-software
https://hexagon.com/company/divisions/manufacturing-intelligence/msc-software
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Overview
This chapter describes what you need to know and have available to install the Adams 2023.1% suite of
software. It contains the sections:

m Welcome to Adams Products, 3
What You Need, 4
Types of Installations, 5

Product Categories, 6
Getting Help, 7
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Getting Started

Welcome to Adams Products

Adams products provide you with tools to model, simulate, and optimize your mechanical systems. This
guide explains how to install and license the Adams products, and gives you troubleshooting tips if you have
any problems during an installation.
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What You Need

Before you start installing Adams products, there are a few things that you should be sure to do or have
available:

m Check to ensure that your system meets the requirements detailed in the Hardware and Software
Specifications, 11. There, you will find Operating System, Compiler, Graphics, Licensing, Memory
and Disk Space requirements. Please review these requirements before beginning your installation of
Adams.

® Hexagon License Electronic Mail. Authorization codes are e-mailed to you by Hexagon. The Adams
applications will not run without proper authorization codes. Following the instructions in the e-
mail, you can export these codes to a file and use them as input to the installation process.

® Obtain any Adams software updates at the Hexagon Technical Support Web site at
http://simcompanion.hexagon.com.

About Your Adams Licenses

To run the Adams products, you need the authorization codes electronically mailed to you by Hexagon.
When you receive this e-mail, copy it's contents to a file as explained in the e-mail message. The actual
authorization codes are contained between the lines:

# ————— Start of License File —-————-

and

# ————- End of License File ---—---

You should only copy the contents of the e-mail between these two lines to a file. This file can be used as
input to the installation process.

If you have an existing MSC license, you may not receive a new set of authorization codes. However, you will
need to know the name of the license server and the TCP port number used by the MSC license manager on
that license server.

About the Adams Media

You will receive your Adams media in the form of an electronic download. All the files required to install the
Adams products will be contained in this media. There is a unique download for each supported Adams
platform. To install Adams for multiple supported platforms, you will have to run the installation process
multiple times with requisite platform installer.


https://simcompanion.hexagon.com/customers/s/
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Types of Installations
The way in which you install and license the Adams products depends on your installation configuration.
Any given installation configuration is composed of the following three components:

m File server - Machine that contains the Adams files. It may be shared with other computers on a
network.

m License Server - Machine that runs the Adams license server. The licensing of Adams products
depends on the type of license you purchased.

m Client - Machine that runs the Adams products.

You can manage these three components on one machine, three different machines, or any combination of
machines. You can also install Adams products on a heterogeneous network where you install Adams
products for different platforms all on one network. For information on the various Linux configurations,
see Linux Installation Roadmaps, 99.
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Product Categories

Product Categories

The product(s) or feature package you are licensed to use for Adams appear on the first page of your password
certificate under the section Feature/Password. When you install the products, select the packages that you

are licensed for.
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Getting Help

If you have questions or problems installing or testing your Adams products, refer to Troubleshooting, 91. If the
problems persist, go to the Technical Articles or Known Issues at http:/simcompanion.hexagon.com/. If the
problems still persist, call Hexagon Technical Support. For a current list of phone numbers and language-
based email addresses please visit our web site http://www.hexagon.com, scroll down and click on Services —
Technical Support (SimCompanion), on the SimCompanion webpage select Support — Support Contact
Information. Before contacting Technical Support, please have the following information available:

m Hardware type (be as specific as possible)
m Version of the operating system, including build number and service packs, if applicable
m Version of compilers

m Hardcopy of all error messages (you can send it by fax or through e-mail)

If possible, generate a troubleshooting report as explained in Generating Problem Reports, 93.


https://simcompanion.hexagon.com/
https://hexagon.com/company/divisions/manufacturing-intelligence/msc-software
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Overview

This chapter provides the hardware and software configurations for Adams.

For the latest version of the hardware and software specifications, see the Adams Support site
at http://simcompanion.hexagon.com

This chapter includes the following sections:

m Hardware and Software Specifications, 11
m Compiler Requirement Details, 15

m System Requirements, 17

m Graphics Requirements, 18

m Licensing Requirements, 19

m Dropped Platforms, 20


https://simcompanion.hexagon.com/customers/s/
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Hardware and Software Configurations

Hardware and Software Specifications

Table 2-1 outlines the hardware and software specifications for Adams.

Intel &
AMD
x86-64

Linux

Intel &
AMD
x86-64
Windows

Table 2-1

Intel Pentium 4,
Pentium D, Core 2
Duo, Xeon, and
compatibles

Intel Pentium 4,
Pentium D, Core 2
Duo, Xeon, and
compatibles

Hardware and Software Specifications

Hardware Models and .

Red Hat Enterprise
Linux 7.9 x64 (Kernel
3.10.0-
1160.el7.x86_64)

Red Hat Enterprise
Linux 8.6 x64 (Kernel
4.18.0-
425.13.1.el8_7.x86_64)

SuSE 12 SP5 Linux
Enterprise Server
(Kernel 4.12.14-
122.147-default)

SuSE 15 SP3 Linux
Enterprise Server
(Kernel 5.3.18-
150300.59.106-default)

Windows 10 Enterprise
Version 21H2 (OS Build
19044.2728)

Windows 11 Pro 21H2
(OS Build 22000.1335)

Windows 10 Pro 22H2
(OS Build 22621.1413)

Windows Sever 2019
1809 (OS Build
17763.2114)

Windows Server 2022
21H2 (OS Build
20348.1129)

Intel oneapi 2022

Version 2021.6.0
Build
20220226_000000

Intel oneAPI 2022

Version 2021.6.0
Build
20220226_000000

Intel oneapi 2022

Version 2021.6.0
Build
20220226_000000

Microsoft Visual
Studio Professional
2022

Version 17.1.7
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section.

1. Intel IA-32 and x64 processors: Pentium (4, D), Core (i3, i5, i7), Xeon and AMD compatibles.
2. Adams 2023.1 product developed using the 'Intel Composer Edition" compiler.

3. Adams Controls is supported on these platforms. However, partner product support varies. Please
see the Supported Versions of Integration Products section of the Adams product Release Guide.

4. Conditions under which compilers are required are listed below in Compiler Requirement Details

5. For the latest information on supported platforms for upcoming releases of MSC products, please
visit the following web site: http://www.hexagon.com/platform-support/

6. Adams officially supports the Professional Edition of Microsoft Visual Studio, but the Community
Edition has been found to function in the following scenarios:

* DLL generation for user-written subroutines in C or in C and Fortran

* Some Adams Controls scenarios with MATLAB/Simulink, Easy5 and FMI compliant
software. For details, please see the Supported Versions of Integration Products section of the
Adams product Release Guide.

The required compiler versions for this version of Adams are found in the Hardware and Software

Specifications section. The conditions under which compilers are required and any deviations to the generally

required versions are listed below:

User Subroutines
with Easy5
Function Evaluation
Co-Sim

ESL Import

with MATLAB/Simulink’
Function Evaluation
Co-Sim

ESL Import

with FMI

Co-Sim

Model Exchange/Import

Table 2-2 Intel & AMD x86-64 Windows

Adams Controls and Adams
Mechatronics FORTRAN Compiler C/C++ Compiler

Required

Not required by Adams’
Not required by Adams”
Not required by Adams
Not required by Adams
Not required by Adams

Not required by Adams

Not required by Adams®

Not required by Adams®

Required

Not required by Adams”
Not required by Adams”
Not required by Adams”

Not required by Adams*
Not required by Adams”
Not required by Adams™

Required in case of co-sim V1/V2 FMU
export (slave). Not required for V1/V2
Adams master.?®

Not required by Adams*®


http://simcompanion.mscsoftware.com/infocenter/index?page=content&id=DOC9283
https://hexagon.com/support-success/manufacturing-intelligence/design-engineering-support/platform-support
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*EasyS requires Intel Fortran
**EasyS requires GNU Compiler Collection or Intel Fortran; Intel recommended
"Easy5 requires Visual Studio linker; note that some FORTRAN compiler environments include this

*MATLAB/Simulink may require it under some circumstances; check with The MathWorks, Inc. for
compiler requirements

#*MATLAB/Simulink” requires it for building the .dll to be exported; check with The MathWorks, Inc. for

compiler requirements

SEMI with Easy5 requires GNU Compiler Collection or Intel compiler
$SEMI with Easy5 requires GNU Compiler Collection or Visual Studio C compiler
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Table 2-3 Intel & AMD x86-64 Linux
Mechatronics FORTRAN Compiler C/C++ Compiler

User Subroutines Required Required
with Easy5
Function Not required by Adams~  Not required by Adams
Co-Sim Not required by Adams~  Not required by Adams
ESL Import Not required by Adams~ Not required by Adams
with MATLAB/Simulink
Function Not required by Adams Not required by Adams*
Co-Sim Not required by Adams Not required by Adams*
ESL Import Not required by Adams Not required by Adams™*
with FMI
Co-Sim Required in case of co-sim  Not required by Adams®

V1/V2 EMU export

(slave). Not required for

V1/V2 Adams master®
Model Exchange/Import Not required by Adams®  Not required by Adams®

*EasyS requires Intel Fortran

**EasyS requires GNU Compiler Collection or Intel Fortran; Intel recommended

*MATLAB/Simulink may require it under some circumstances; check with The MathWorks, Inc. for
compiler requirements

*#*MATLAB/Simulink requires it for building the .dll to be exported; check with The MathWorks, Inc. for
compiler requirements

SFMI with Easy5 requires GNU Compiler Collection or Intel compiler
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System Requirements

Table 2-4 shows the system requirements for Adams.

Table 2-4 System Requirements
m Operating System Disk Space Memory and Swap Space
Intel & AMD Red Hat Enterprise Linux 7.9 19 Gb 1 Gb Minimum
x86-64 Linux x64 (Kernel 3.10.0- 2 Gb Recommended
1160.el7.x86_064) Swap = 2 x RAM

Red Hat Enterprise Linux 8.6
x64 (Kernel 4.18.0-
425.13.1.el8_7.x86_064)

SuSE 12 SP5 Linux Enterprise
Server (Kernel 4.12.14-122.147-
default)

SuSE 15 SP3 Linux Enterprise
Server (Kernel 5.3.18-
150300.59.106-default)

Intel & AMD Windows 10 Enterprise Version 13 Gb 1 Gb Minimum
x86-64 Windows 21H2 (OS Build 19044.2728) 2 Gb Recommended
Swap = 2 x RAM

Windows 11 Pro 21H2 (OS
Build 22000.1335)

Windows 10 Pro 22H2 (OS
Build 22621.1413)

Windows Sever 2019 1809 (OS
Build 17763.2114)

Windows Server 2022
21H2 (OS Build 20348.1129)

Ubuntu Linux 20 and 22.04 are also supported, but only for standalone Adams
Solver jobs including those that use Adams Controls and/or Adams Car Solver
extensions.

The CSH shell is required for the installation and use of Adams on Ubuntu. Using
another shell, such as bash, will result in unexpected behaviour.
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Graphics Requirements
The following are the graphics requirements for Adams.

Table 2-5 Graphics Requirements

System Runtime
Operating System Libraries Validated Graphics Hardware

Intel 8& AMD x86-64 Red Hat Enterprise Linux ~ X11 and OpenGL ~ NVIDIA Graphics Driver - Quadro M2200

Linux 7.9 x64 (Kernel 3.10.0- 1.2+ Version 515.76
1160.el7.x86_64)
For RHEL 7.9 use NVIDIA Graphics
Red Hat Enterprise Linux Driver — Quadro M2200 Version 515.76
8.6 x64 (Kernel 4.18.0-
425.13.1.¢l8_7.x86_64) For RHEL 8.4 use NVIDIA Graphics
Driver — Quadro M2200 Version 515.76
SuSE 12 SP5 Linux
Enterprise Server (Kernel For SUSE12 SP5 use NVIDIA Graphics
4.12.14-122.147-defaulo) Driver — Quadro M2200 Version 515.76
SuSE 15 SP3 Linux For SUSE15 SP2 use NVIDIA Graphics
Enterprise Server (Kernel Driver — Quadro M2200 Version 515.76
5.3.18-150300.59.106-
default) The Adams products have been developed
in full compliance with OpenGL 1.2 and
should run properly with graphics cards that
adhere to the 1.2 or later specification. Must
install vendor supplied OpenGL video
driver.
Intel & AMD Windows 10 Enterprise OpenGL 1.2+ NVIDIA Graphics Driver - Version 462.3
x86-64 Version 21H2 (OS Build Quadro M2200
Windows 19044.2728)

Windows 11 Pro 21H2
(OS Build 22000.1335)

Windows 10 Pro 22H2
(OS Build 22621.1413)

Windows Sever 2019 1809
(OS Build 17763.2114)

Windows Server 2022
21H2 (OS Build
20348.1129)

AMD Radeon™ Pro W6600M Graphics
Driver - Version 31.0.12026.3004

The Adams products have been developed
in full compliance with OpenGL 1.2 and
should run properly with graphics cards that
adhere to the 1.2 or later specification.

Avoid use of the CPU-integrated graphics
hardware.
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Licensing Requirements

Following are the Adams licensing requirements for obtaining a node locked license file. Note that when
obtaining licenses from a server, this version of Adams requires access to MSC License Server (FLEXIm)
v11.13 or greater (installed separately).

Table 2-6 Licensing Requirements
m Hostname Retrieval Host ID Retrieval
Intel & AMD From a shell window, enter the command: From a shell window, enter the command:
x86-64
Linux hostname /sbin/ifconfig eth0
Return the information in the line labeled "HW addr"
and remove the colons ":".
Intel & AMD From a “Command Prompt” window, enter From a "Command Prompt" window, enter the
x86 and the command: command:
x86-64
Windows hostname ipconfig /all

Return the information in the line labeled "Physical
Address".
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Dropped Platforms

Each release we review the platforms and operating system changes by our partners and in the industry, and
address these changes in our release. We make this information available to you for hardware planning. We
welcome your input on platform support. Please communicate platform support needs to your MSC Sales

Representative.
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Overview
This chapter provides instructions for installing the Adams software. It contains the sections:
m Preparing to Install the Adams Product, 21
m Creating the Installation Directory, 22
m [nstalling Adams, 23
m [nstalling the Adams Controls Thin Client, 32
m Installing the Adams Extension for Easy5, 33
m [nstalling on a Heterogeneous Network, 35

After installing the Adams products, you need to set up the licenses to run them. See Licensing on Linux, 37 for
more information.

For general steps (roadmaps) for the various Linux configurations, see Linux Installation
Roadmaps, 99



CHAPTER 3 | 21
Installing Adams on Linux

Preparing to Install the Adams Product

The primary way to receive the Adams product is by downloading the software from the Software Download
Center (SDC). In the case of Linux products, this will be an executable installer for each platform. The
download file will have a .bin extension.

Select the platform file from the SDC. Download the file to a temporary directory on a file system with
enough available space.

Follow the directions in this document for installing Adams from this executable installer.

Installers always copy to the /tmp location, if the /tmp partition is too small, it is not
possible to run the product on the machine. It is reccommended to set the environmental
variable ‘HMI TMP DIR=/file location’ which changes the default location for
extracting installer files to the specified directory.

An example is shown below:

HMI TMP DIR=/scratch - Executing this variable will extract the files to scratch folder

B 10137471
Terminal ~ Sessions  View  Xserver Tools Games Settings  Macros  Help
a® - n
% % s x E B Y B & €
Session  Servers Tools Games  Sessions View Split MultiExec Tunneling Packages Settings He

Quick connect...

« = +tTOm Al .
‘fscratchr a
E 5 Mame Size (KB) Last modified Owner Group
2 .
a2021_2_2 patch3 2022-03-1509:26 root root
Actran_2021 2021-06-08 16:53 root root
® adams2021_2_2_sdc 2022-03-15 06:13 root root
§ dhananjay 2023-02-07 05:14 root root
:‘\ installer_files 2023-03-25 12:45 at
MATLAB 2021-05-05 19:37 root root
g msc. 2022-05-23 23:47 at
& nfe_adur_caef_V5 2021-08-26 12:54 root root
= ) 2021-07-28 14:26 root roat
o | installer.tar.gz 5004 796 2023-03-27 08:47 at
a
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Creating the Installation Directory

This section explains how to create an installation directory in which to install the Adams products. This is
the location on your file server where you want the Adams products to reside.

To create the installation directory:
1. Log on to the Linux system where you want to install the Adams products (the file server).

2. Create a directory in which to place the Adams products by entering the following command, where
install dir is the directory that you want to create:

mkdir install dir

We recommend that you create a directory called /usr/adamsx for the Adams products. In the
directory name, x represents the current version of Adams. If you have a prior version of Adams on
your system, you should install the new version in a different location. If, however, you are adding
the same version of software to an existing installation, place the new software in the same location.
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Installing Adams
This section contains instructions for starting the Adams installation program.

After downloading Adams from the Software Download Center (SDC), you will run the installation program
from the directory you unloaded the executable installer into.

The CSH shell is required for the installation and use of Adams on Ubuntu. Using another
shell, such as bash, will result in unexpected behavior.

The installation program has command line options available to help you tailor the installation to your site's

needs.

Running the installation program without any options will launch it in graphical mode. Running in
graphical mode uses the X-Windows display protocol. You must have the X-Windows DISPLAY variable set
to a valid display to run in graphical mode.

Available Options:

—-help Display this information

-is Set this mode to run the installer in Silent installation mode.
Use -s along with silent file name

-i console Set this mode to if you want to install Adams through console mode by
manually entering required input via Linux console without GUI install

shield display

The installation responses are often system specific, it is not recommended to use the responses from one
platform installer on other supported platforms.

The most common combinations are provided as examples below because Hexagon changes the name of the
installation program to include product and release version number. The generic name "installer.bin” is used
to represent the name of the installer in these examples.

The installation program will install in graphical mode by defaul.

1. Move to the installation directory you previously created.

2. Locate the installation program, adams_XXXXXX PLAT.bin, in the download directory. The full
path to the installation program will be needed to run it.

where XXXXXX is the release version, and PLAT is the platform name that corresponds to the
platform you wish to install. For example:

adams_2023_1_linux64_rhe79.bin

3. Start the installation program, the welcome agreement window will appear as shown below.
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F] IzPack - Installation of Adams@xl-in-TT7g3q2 - x
Welcome

Welcome to the installation of Adams 2023.1

e recommend that you exit all the Windows programs before running this setup program.
(Copyright ®2023 Hexagon AB and/or its subsidiaries. All rights reserved.

arning: This computer program ("Software"] is protected by intellectual property law
including trade secret law, copyright law and international treaties.
Reproduction or distribution in any manner requires written permission of Hexagon AB andfor
its subsidiaries under the terms of a valid license. Unauthorized reproduction or distribution of]
thiz Software, or any portien of it, may result in severe civil and criminal penalties.

lnti-Piracy and License Compliance - Motice

[The Software may contain & security and reporting mechanism ("Security Mechanism"}
intended to automatically collect and transmit to Hexagon Manufacturing Intelligence, Inc.
and its affiliates (and their contractors, representatives, successors and assigns] data
relating to the installation and usage of the Software, for purposes of verifying user
compliance with the terms of the applicable license agreement, identifying unauthorized use
and users, and otherwise protecting and enforcing intellectual property rights. Data collected
and transmitted through the Security Mechanism may include, without limitation, user, device,
and network identification information such as, but not limited to, email address, username,
hostname, MAC address, IP address, Wi-Fi S5ID, geclocation and organization domain
information, as well as information on Software usage, including product name, version, and
time and number of uses, For further information on Hexagon's use and processing of
personal data transmitted and collected through the Security Mechanism, see Hexagon's
online privacy statement, as maybe updated from time to time, available at

https:/fhexagon com/legal/mi-privacy-notice (or successor web pages).

To quit with setup program, click "Cancel”
[To continue with the setup program, click "Acknowledged"

[Made with |zP ack - hitp/izpack.orgl) —
Step1of 9 [ % acnowledged || @ cancel |

Figure 3-1 Welcome Agreement Window

4. Select Acknowledged > button to continue, or Cancel button to exit without installing.

5. Select the full path to the directory you want to install Adams in. You can type in the directory path
after selecting the Browse button, or use the directory tree to locate the installation directory.
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¥ izPack - Installation of Adams@xl-in-T77g3q2 - x
Target Path

Select the installation path:

[imsciadams/2023 1 | E Browse...

(Mads with 1P ack - Htpilizpack. aral)

Step Zof 9 | d@previous |[ @ ned || @cancel |

Figure 3-2 Selecting Installation Directory Window

6. Select the packs you want to install.
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F 1zPack - Installation of Adams@xl-in-777g3q2 — Y
Select Installation Packages
Select the packs you want to install:
Note: Grayed packs are required.
¥ Adams Core Applications 11.23 GB
¥ adams Car Applications 3.58 GB
[v  aAdams Controls Thin Client 10.48 MB
¥ adams configuration files 42,97 KB
¥ Adams Solver NLFE client 3.58 GB
Description
Adams Core Applications (Solver, View, Insight, PostProcessor)
Total space required: 18.38 GB
Available space: 264.85 GB
[Made with |2P ack - hitp:fizpack.argl) — =
Step 30f 9 ‘ < Previous ‘ | B> Next. || @ cancel ‘
Figure 3-3 Selecting Installation packs

7. Select the Next > button to confirm your installation selection (s). A progress dialog box will be
displayed. You can select the Cancel button at any time to stop the installation.
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¥ lzPack - Installation of Adams@xl-in-TT7g5q2 - x
Summary Configuration Data

Installation will proceed with the following settings. Press Next to continue.
Installation Path

Jmsc/idams/2023 1
Chosen Installation Packs

Adams Core Applications

Adams Car Applications

Adams Controls Thin Client

Adams configuration files

Adams Solver NLFE client

(Made with 12P ack - httpifizpack.orgl)

paofo | <3 previous || B> Next H @ cancel ‘

Figure 3-4 Installation Progress Window

8. You must select your HTML Browser that will be used to access all documentation that you have
installed. You can type in the full path after selecting the Browse button, or use the directory tree to
locate the browser.
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F{ 1zPack - Installation of Adams@xl-in-T77g5q2

= X
User Data
Enter Vour Internet Browser Path
Path: [fusr/binfirefo:] \
[Made with 12P ack - httprfizpack orail
‘ @Ereviouﬁ || @ﬂext H @gancel |
Figure 3-5 HTML Browser Selection Window

9. The Licensing dialog box allows you to choose the method of communications with an Hexagon
License Manager. The most common method for communicating with the license manager is a
port@host connection. This is the TCP port number your license manager is listening to, and the
hostname of the system that is running the license manager processes. The standard Hexagon License
ManagerTCP port number is 27500.
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FT IzPack - Installation of Adams@xl-in-777g5q2 - X
Licensing

Configure licensing
If you already have a FLEXIm license server installed, specify the location of the license

manager using the License field below.If you are not sure what to do just click Next, consult
with your Systern Administrator and set it [ater.

Examples:

1)27500@hostname

or

2)27500@hostname: 27500@hostname2: 27500@hostname: 3

or
3¥msc/MSC.Software/MSC. Licensing/.. ficense.dat

\
Browse...

(Made with 1zP ack - http:ifizpack orar) —

| '@Erevinus || @ﬂext H @gancel ‘

Figure 3-6 License Setup Window

10. Select Next > button to continue.
After the Processing asummary dialog box announces the completion of the installation process and
provides final instructions for license manager communication changes should you need to change
that setting in the future. It also provides the Hexagon Technical Support e-mail address. Selecting
Finish will complete the installation process.



30 | Adams 2023.1 Installation and Operations Guide
Installing Adams

- X

Installation Finished

(Made with 1zP ack - http:fiizpack orgf]

Installation has completed successfully.

F1 Save@xl-in-777g5q2 x
sovern: [B20733 & B
acar amad
acoustics E} amec
adamspy appb.
damssdk aride
driveline atire
aevhybrid [E atrike
explore atrud
ainsight aview
4] Ii | [»
File Name: [auto-install.xml |
Files of Type: |All Files I~

ImscfAdams/2023 1/Uninstaller

‘ @generate an automatic installation script ‘

Figure 3-7

11. If you chose to install either the Adams package or the Adams Advanced package, you will need to
setup the Adams Extension for Easy5. For more information, refer to Installing the Adams Extension for

Easy5, 33

Other than the default standard installation, you will encounter various installation scenarios. The following
lists the common standard scenarios used in Adams.

Scenario 1:

Linux typically involves running the installer without any user intervention or interaction. If you want to
install Adams using the silent installation option, then in command-line use “-s” along with silent file name

installer.bin -s auto_instal.xml

Installation Complete Confirmation Window

The silent installation process should start and run without any user intervention.
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The file auto_instal.xml can be generated after you select Generate an automatic
installation Script option at the end installation. See Step 10.

— * j
Installation Finished

Installation has completed successfully.

1 save@xl-in-T77g5q2 x
save In: 20231 [+]
acar amacl
acoustics amed
adamspy apph
adamssdk aride
adriveline atire
aevhybrid atrike
aexplore atrucl
ainsight aview
[ il ] >

File Name: |autu-matall‘xml |

Files of Type: [All Files ]

fmscfAdams/2023 1/Uninstaller

| (% Generate an automatic installation script ‘

(Made with |2P ack - http:fiizpack orgf] —

i ,

Scenario 2:

You have tried to install, but the installer reports that it does not have enough file system space to create
temporary files during the installation. If you are facing space issue in /tmp directory, you can change
extraction location for installer files using environment variable.

Set HMI_TMP_DIR to directory of your choice.
Example: export HMI_TMP_DIR=/root/testing

Scenario 3:

You are installing on a system that does not have a system console running an X-Windows server. If you want
install Adams through console mode by manually entering required input via Linux console without GUI

install shield display.
installer.bin -i console

The -i console mode will use text prompts to answer the questions required to install. You can use -7 console
mode with all other options.
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Installing the Adams Controls Thin Client

The Adams Controls Thin Client is a subset of Adams Controls. This client can be helpful to Easy5 or
MATLAB users who want to use TCP/IP communication when performing co-simulations with Adams
Controls, but don’t want a full Adams installation.

To install the Adams Controls Thin Client:

1.

Follow Step 1. on page 23 to Step 5. on page 24.

2. Select only Controls Client Applications and Next
3.
4

. Select Finish from the last dialog box to complete the installation

Select Install from the Product Selection Summary dialog box.

You must install the Adams Extension for Easy5 to use the Adams Controls Thin Client with
Easy5. For more information, see Installing the Adams Extension for Easy5, 33.
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Installing the Adams Extension for Easy5

m This procedure is only necessary if you installed Adams Controls.

To run Adams and Easy5 together, you must install the Adams extension into Easy5. To import models into
Adams that were exported from Easy5 (containing components from licensed Easy5 libraries), you must also
configure your computer so that Adams knows how to find your Easy5 license. The following procedures
explain how to do this.

To install the Adams extension for Easy5:
1. Make sure that both Easy5 and Adams have been installed.

2. Make sure you have permission (that is, root (‘'superuser’) privilege) to add and modify files in the
Easy5 installation directory.

3. Identify the command line command used to start the Adams version you will use with Easy5, for
example, adams2023_1.

If you are unable to identify a command line command to run Adams but you can
identify the top-level directory of the Adams installation, you can use -d
directory path in place of the command line command in the following steps.

4. Perform the following:

a. Open an xterm window and set your working directory to a directory outside the Easy5
installation directory tree.

b. Start Easy5. The standard command is easy5x.
c. In the Easy5 main window, from the File menu, select Open Command Shell.
d. At the prompt in the command shell, enter:
$EZHOME/install_adams_controls.ksh adams_command
where adams_command is the command line command from Step 3 above.
5. Type exit to close the command window.
6. Ifyou started Easy5, from the File menu, select Quit.

The Adams extension installation is complete. Be sure to configure your computer as described next.

To configure your computer to run licensed exported Easy5 models within Adams:
1. Start Easy5.
2. From the File menu, select Open Command Shell.

3. At the prompt in the command shell, type easy5x --license.
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Easy5 displays the licensing information, beginning with the type of license and the server name (if a
server license) or the path to the license file.

4. Write down the contents of the line that starts with Active license file(s), and the value that appears
in the line following it (for example, 27500@rainier).
5. Perform one of the following:
o Ifthe line is Active license file(s) [EASY5_LMD_LICENSE_FILE], set the environment variable
EASY5_LMD_LICENSE_FILE to the output value displayed in Step 4 above (for example,
27500@rainier).

o If the line is Active license file(s) [MSC_LICENSE_FILE], find the value of the environment
variable MSC_LICENSE_FILE to see what license file Adams is using.

e If Easy5 and Adams are using different licenses (or license servers), set LM_LICENSE_FILE to
the value for the Easy5 license (for example 2500@bosco).

e If Easy5 and Adams are using the same license, your computer is configured properly.
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Installing on a Heterogeneous Network

If you are installing the Adams products for use on different Linux platforms (Sun, HP, and so on) you are
performing a heterogeneous installation. Adams installation directory can support multiple platforms.
Binary files specific to each supported platform are located in architecture directories under each product
directory. You can use a single installation directory to install all supported Adams platform binaries or
multiple file servers to spread out the file serving load to multiple systems.

To install Adams on a heterogeneous network:
m Follow the instructions in Installing Adams, 23, for each platform on which you are installing Adams

products.
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Overview

This chapter provides instructions for licensing the Adams software. You must complete the steps in Installing
Adams on Linux, 19 before licensing the Adams software. Refer to Linux Installation Roadmaps, 99 for which
procedure in this chapter to follow depending on your system configuration.

The chapter contains the sections:

About the Adams License Server, 39

Licensing Adams When File and License Server Are Same Machine, 40
Licensing Adams When File and License Server Are Different Systems, 41
Starting the Adams License Server, 42

Restarting the Adams License Daemons, 43

Changing the License to Point to a Different License Server, 44

Verifying a Successful License, 45
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About the Adams License Server

Adams licensing requires that you operate at least one license server. You can optionally request to use three
Adams license servers (see About a Three-Server Configuration below). The Adams license servers can be on
any of the supported Adams platforms connected to the network that runs the Adams products. Adams uses

the FLEXJm®, license system from Flexera Software.
The following sections give you tips for selecting the license server and explain different configurations:

m Tips for Selecting a License Server, 39
m About a Three-Server Configuration, 39

Tips for Selecting a License Server

You should select the machine to use as your Adams license server using the following guidelines. The
machine should:

m Have a local file system that can hold the Adams license server software. If you use a remotely
mounted file system for your Adams license server, you risk having your users unable to run the
Adams products if the server goes down. You should never run the Adams license server from a
diskless node on the network.

m Have enough system resources to robustly serve the number of Adams users requesting a license.

® Be on the same local area network (or sub-net) if the number of Adams license requests is in the
range of hundreds per day.

m Be reliable. This means that it has reliable power and its hardware subsystems are in good working
order.

You should consolidate your licenses because redundant license servers add complexity. Evaluate what you
really want to achieve by using redundant license servers. More robust hardware systems, instead of
redundant license servers, can better ensure less down time. You should look at ways to consolidate the
number of license servers at the departmental, division, or even at the company-wide level.

About a Three-Server Configuration

For each of the license types, you can have three machines on your network that are designated as license
servers. Selecting three license servers lets you back up the main license server in case one of the other
machines is down. If your password certificate lists three machines under the Server Host Name column,
you purchased the three-server configuration. You must install your passwords on each of the servers as
explained in Licensing Adams When File and License Server Are Same Machine, 40.

You should log in to one of the servers and open three shell windows. Log in to the other two servers in the
different shell windows and repeat the procedures in this chapter for each server. You also need to start each
of the license servers as explained in Starting the Adams License Server, 42. The order of startup is not critical.
The first machine, however, to start the license daemons becomes the master server and serves licenses until
it is unavailable.
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Licensing Adams When File and License Server Are
Same Machine

Follow the instructions below if your license server and file server are the same machine. You should log in

to the system that appears in the Server Host Name column on the password certificate.

To set up licensing:

1.
2.
3.

From the Installation directory start the installation program INSTALL.ADAMS.
Enter 1 to select the option, Install Adams passwords on this license server.

Entery if the name of the Adams license server that appears in the prompt is the same as the machine
designated as the server in your e-mail password certificate. (Depending on the type of license you
have, the server name may not be listed in your e-mail certificate; in this case, use the hostid instead.)

The default is the machine to which you are logged on. If this is not your license server, enter n, log
in to your license server, and start the procedure again.

Follow the instructions in the e-mail password certificate to locate the information required for
licensing your Adams software.

6. At thepromptAre your passwords in a file e-mailed from MSC Software?, entery.

Enter the name of the text file that contains your passwords.

The installation program reads this file and constructs a properly formatted license data file
(license.dat) for you.

If the installation program cannot read the file, open the original file and verify that you cut the
information required for licensing at the correct locations.

Continue with Starting the Adams License Server, 42.
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Licensing Adams When File and License Server Are
Different Systems

Follow the instructions below if your license server and file server are different systems or if you purchased a
three-server configuration. You should log into a system that appears in the SERVER HOST NAME column
on your password certificate.

If you are installing passwords for a three-server configuration, you should log into one of the servers and
open three shell windows, one for each server. Use two of these windows to remotely log into the other license
servers and repeat the instructions in this section for each server.

If you are not familiar with the FLEXIm license system you should install the license manager from the
Installation Program and use the automation described below.

Start the Installation Program as described on page 23 of this manual

Enter the Installation directory

Select the User Selectable installation type

Select Install after confirming your package selection, and Finish at the last dialog box.

Move to the installation directory you specified in Step 2. above

AN o

Run the INSTALL . ADAMS installation script

a. Enter 1, to enter passwords supplied by e-mail

b. Enter 2, to start the license manager on the system you are logged into
c. Enter7, to exit

You should continue with Restarting the Adams License Daemons, 43

For more information, see Hexagon Licensing document.
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Starting the Adams License Server

Follow the instructions below for all of the license types, as well as the three-server configuration. For three-
server configurations, you must repeat this procedure on each license server. You must enter the commands
on each license server within one minute.

To restart the Adams license server:
1. Start the installation program INSTALL.ADAMS.

2. At the prompt, enter 2 to select the option, Start the Adams license server on this system. The Adams
license daemons are automatically started.

Continue with the next section to allow the license daemons to automatically restart when you reboot
your system.
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Restarting the Adams License Daemons

You must modify the reboot procedure on your license servers to include a restart of the Adams license
daemons during a system reboot.

To restart the Adams license daemons:
1. Change to the directory /msc/Adams, where msc is the directory where the Adams products are
installed.

2. Locate the file reboot.txt based on your platform.

To add the Adams license server startup commands, follow the instructions provided by your
operating system.

The licensing of Adams products is complete. You can now verify that installation was successful by following
the procedures in Verifying a Successful License, 45.
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Changing the License to Point to a Different License

Server
1. Start the installation program with the client argument (for example, install.adams client) or select
option 4.

2. Enter the port number that is used by the license server.

3. Enter the name of the Adams license server that has the licenses you want to use. This can be a
different machine than the machine on which you installed the Adams products, which is the file
server.
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Verifying a Successful License
Follow the procedure below to verify that the Adams installation was successful.
1. Start the installation program on the license server INSTALL.ADAMS.

2. Atthe prompt, enter 5 to select the option, Generate a problem report. This automatically generates
a report called PROBLEM. RPT that you can use to verify the Adams installation.

3. Using a text editor, open the PROBLEM. RPT file and review the information. Verify that each of the
features installed are able to retrieve a license.
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Overview

The following sections explain how to install Adams 2023.1 products and online documentation by running
the Adams 2023.1 installation program. It also includes information on licensing your Adams 2023.1.

m Installing Adams, 48
® Installing the Adams Controls Thin Client, 59
m Installing Adams in Silent Mode (Batch), 63

Installing Adams

This section shows you how to install Adams software and documentation.

To install Adams:

1. Open Windows Explorer, browse to your Adams download and double click the Adams 2023.1 self

extracting executable file.

The language selection window will appear as shown below:

Setup Type

Please select the language

@ English

" Japanese

< Back Next >

Cancel

Figure 5-1 Setup Type Window
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2. Ifyou select “English” the welcome agreement window will appear as shown below.

Adams 2023.1

Adams Installation

We recommend that you exit all the Windows programs before running this setup program.
Copyright ©2023 Hexagon AB and/or its subsidiaries. All rights reserved.

Warning: This computer program ("Software") is protected by intellectual property law including
trade secret law, copyright law and international treaties. Reproduction or distribution in any
manner requires written permission of Hexagon AB andfor its subsidiaries under the terms of a
wvalid license. Unauthorized reproduction or distribution of this Software, or any portion of it, may
result in severe civil and criminal penalties.

Anti-Piracy and License Compliance - Notice

The Software may contain a security and reporting mechanism {"Security Mechanism") intended
to automatically collect and transmit to Hexagon Manufacturing Intelligence, Inc. and its affiliates
{and their contractors, representatives, successors and assigns) data relating to the installation
and usage of the Software, for purposes of verifying user compliance with the terms of the
applicable license agreement, identifying unauthorized use and users, and otherwise protecting
and enforcing intellectual property rights. Data collected and transmitted through the Security
Mechanism may include, without limitation, user, device, and netwark identification information
such as, but not limited to, email address, username, hostname, MAC address, IP address, Wi-Fi
551D, geolocation and organization domain information, as well as information on Software
usage, including product name, version, and time and number of uses. For further information
on Hexagon's use and processing of personal data transmitted and collected through the
Security Mechanism, see the Hexagon Manufacturing Intelligence privacy notice, as maybe
updated from time to time, available at https:/fhexagon.com/legal/mi-privacy-notice (or
successor web pages).

To quit with setup program, click "Cancel”,

| Acknowledged Cancel

Figure 5-2 License Agreement Window - English

49
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3. Ifyou select “Japanese” the welcome agreement window will appear as shown below.

Adams 2023.1 hd

Adams{ AP —ALICE

COEyh Py IS IAEE T TS ACE TP OINTOWindows TN IAEIS T LTS,
Copyright (C)2023 Hexagon AB and/or its subsidiaries. BB fEE - Br#iF 52030,

[EEICOTLE2 B -J003L T IVINII7 D 3, BREL. EMHELDLUERS
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Figure 5-3 License Agreement Window - Japanese

4. Select Acknowledged button to continue, or Cancel button to exit without installing.

m To re-select the language, click Cancel button to exit and restart the installation.

The Customer Information window appears as shown below.
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Adams 2023.1 x

Customer Information

Please enter your information.

User Name:

‘ abc ‘

Company Name:

‘ abd ‘

Install this application for:

@ Anyone who uses this computer (all users)

¢ Only for me
g < Back Next > Cancel
Figure 5-4 Customer Information Window

5. In the Customer Information window, enter your user and company name, and then select one of
the following:

°* Anyone who uses this computer (all users) - Anyone logged on to this machine can run Adams
2023.1.

* Only for me - A user must be logged on using the user name and password that was used at the
time of installation.
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6. Select Next.

The Setup Type window appears as shown below. Browse to the desired installation folder location.

Installation paths on drives other than the C:\ and including spaces are unsupported.
The installation will proceed, but Adams will fail to launch. If Destination Folder is
on a drive other than C:\ do not select a path with a space in it.

Adams 2023.1 X

Select Setup Type
@ Full Install all Adams products and online help.
(" User Selectable Choose which Adams products you want to install.

Destination Folder

C:\Program Files\MSC.Software\Adams\2023_1
Browse...

< Back Next > Cancel

Figure 5-5 Setup Type Window
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Adams 2023.1 x

Select Setup Type

C Full Install all Adams products and online help.

@ User Selectable Choose which Adams products you want to install.

Destination Folder-

C:\Program Files\MSC.Software\Adams\2023_1
Browse...

< Back Next > Cancel

Figure 5-6 User Selectable

7. Select the type of installation you want to perform:

* Full - Installs all Adams 2023.1 products and documentation. Always use this option if you want
to use this machine as a file server, allowing other machines to client to it.

° User Selectable - Allows you to select the specific Adams 2023.1 packages and documentation you
want to install.

8. Ifyou would prefer Adams 2023.1 to be installed in a folder other than the default destination folder,
select Browse, and then select the desired folder.

The default directory for installing Adams 2023.1 products is
C:\Program Files\MSC.Software\Adams\2023_1.

9. Select Next.
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Start Copying Files

Setup has enocugh information to start copying the program files.
To review or change any settings, click "< Back”.
To begin copying the files, click "Next »".

Current Settings:

Setup Type: Full

Target Directory:
C\Program Files\MS5C.Software’\Adams\2023_1

Required Space: 10786 MB
Awvailable Space: 26126 MB

Installer Information:
User Name: abc
Company Name: abc

Install Application For: Anyone whao uses this computer (all users)

Selected Features:
Adams Packages
Basic Package (required)

Figure 5-7 Installation Settings Confirmation Window
10. Depending on your selection in Step 7., do one of the following:
e Full - Continue to Step 11.

® User Selectable - In the Select Components window, select the components you want to install.
Then, select Next.

You cannot install the Adams Controls Thin Client at the same time as other Adams

2023.1 products. You must install it by itself. See Installing the Adams Controls Thin Client,
59 for more information

11. Confirm the installation settings and then select Next to begin the installation.

12. The License Setup window appears as shown below.
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Adams 2023.1

Adams License Setup

If you already have a FLEXIm license server for Adams installed, specify the location of the license
manager using the following License field. If you are not sure what to do, dlick "Mext ", consult
with your System Administrator, and set it later.

Some examples are as follows:

27500@hostname
. 27500@hostname1;27500@hostname2;27500@hostname3

CAMSC.50ftware\MSC. Licensing\...\license.dat

License: | ‘ Browse...

< Back Next > Cancel

Figure 5-8 License Setup Window

13. Enter the name of the license server or the path to your license file. If you don’t enter this information
here, you can specify your license using the procedure in Specifying your License, 68.

14. Select Next.

15. Specify whether or not you want to install the various desktop icons. If you select Yes, then select the
products for which the icons to be created.

55
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Adams 2023.1

Select Adams Desktop Icons

Desktop icons will be created for the selected Adams products.

[ Adams View

[+ Adams Solver

[+ Adams PostProcessor
[ Adams Car

[+ Adams Driveline

[ Adams Flex

[¥" Adams Insight

inst=lshidld < Back Next > Cancel

Figure 5-9 Adams 2023.1 Desktop Icons Window

16. Select Next.



17.

18.

19.

20.
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The Solver File Association window appears as shown below.

Adams 2023.1 x

Choose Adams Solver File Association

Select the Solver product with which you would like .acf files on this machine associated.

@ Adams Solver
 Adams Car
" Adams Driveline

(" Do not create an association for .acf file types

< Back Next = Cancel

Figure 5-10 Solver File Association Window
Select the solver product with which you want .acf files on this machine associated. You can also select
not to associate .acf files with an Adams 2023.1 product.
Select Next.

A dialog box appears indicating that the file permissions are being changed. If you do not have
sufficient administration privileges you need to contact the system administrator.

Select Next.

If you do not have the Visual Studio Redistributable Package installed, the installer begins the
installation of the following packages:

* Microsoft VC++ 2017 x64 redist — 14.12.25810
* Microsoft VC++ 2019 x64 redist — 14.24.28127
* Microsoft VC++ 2022 x64 redist — 14.32.31326.0
To view the readme file, select I would like to view the README file.
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Installation Complete

Adams is now installed on your computer.

[~ Il want to view the README ﬁle.;

< Back Finish Cancel

Figure 5-11 Installation Complete Confirmation Window

21. Select Finish.

22. Ifyou installed Adams Controls, you need to install the Adams 2023.1 Extension for Easy5.
Previously, this was done automatically by the Adams Controls install program. For more
information, refer to Installing the Adams Extension for Easy5, 33.

23. If you want to use this installation as a file server (so that other machines can install from it), share
the installation directory.
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Installing the Adams Controls Thin Client

The Adams Controls Thin Client is a subset of the full Adams installation. This client can be helpful to Easy5
or MATLAB users who want to:

1. Use TCP/IP communication when performing co-simulations with Adams Controls.

2. Generate an External System Library for Control System Import.

To install the Adams Controls Thin Client:
1. Follow steps Step 1 on page 48 through Step 6 on page 52.

2. In the Select Setup Type window, select User Selectable.
3. Select Adams Controls Thin Client, making sure no other products are selected.
4

. Continue with Step 11 on page 54 and complete the remaining steps in the installation procedure.

m You must install the Adams Extension for Easy5 to use the Adams Controls Thin Client.
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Installing the Adams Extension for Easy5

m This procedure is only necessary if you installed Adams Controls.

To run Adams and Easy5 together, you must install the Adams extension into Easy5. To import models into
Adams that were exported from Easy5 (containing components from licensed Easy5 libraries), you must also
configure your computer so that Adams knows how to find your Easy5 license. The following procedures
explain how to do this.

To install the Adams extension for Easy5:

Check https:/help.hexagonmi.com/ to find the versions of Easy5 that are compatible with
Adams. Select the current version, for example Adams 2023.1 - Online Help (HTML) and
go to Release Guide -> Supported Versions of Integration Products.

Installation of the Adams Controls Extension is performed automatically during the Easy5 installation
process if Adams is previously installed, and you answer "Yes" to the installer prompt asking you to install this
component.

To manually install the Adams Controls Extension:
1. Make sure that both Easy5 and Adams have been installed.

2. Make sure you have permission to add and modify files in the Easy5 installation directory. You need
administrator privileges if the installation directory is located in "C:\Program Files".

3. DPerform the following (As an administrator if Easy5 is installed in "C:\Program Files"):

a. From the Start menu, point to Programs, point to Easy5 <version> and then left-click on Easy5
to launch Easy5.

To run Easy5 as Administrator, right-click on Easy5 and in the menu that pops
up, under "More", select "Run as administrator”. This will launch Easy5 as
Administrator.

b. From File menu in Easy5, Click on "Open Command Shell".
c. At the prompt within the Easy5 command shell type:
install_adams_controls.bat <Adams_topdir> %EZHOME%

where: <Adams_topdir> is the top-level directory for Adams, also provided by "adams2023_1-
top"; EZHOME is an environment variable available in Easy5 Command Shell and it points to
the top-level directory of Easy5 (for example, C:\Program Files\MSC.Software\Adams\2023_1
C:\Program Files\MSC.Software\Easy5\2021.2, respectively).

4. Type exit to close the command window.


https://help.hexagonmi.com/bundle?name_filter.field=title&name_filter.value=&rpp=10&sort.field=last_uploaded&sort.value=desc
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5. Ifyou started Easy5, from the File menu, select Quit.

The Adams extension installation is complete. Be sure to configure your computer as described next.

To configure your computer to run licensed exported Easy5 models within Adams:
1. Start Easy5.
2. From the File menu, select Open Command Shell.
3. At the prompt in the command shell, type easy5x -license.

Easy5 displays the licensing information, beginning with the type of license and the server name (if
a server license) or the path to the license file.

4. Write down the contents of the line that starts with Active license file(s), and the value that appears
in the line following it (for example, 27500@rainier).

5. Perform one of the following:

e If the line is Active license file(s) [Easy5_LMD_LICENSE_FILE], set the environment variable
Easy5_LMD_LICENSE_FILE to the output value displayed in Step 4 above (for example,
27500 @rainier).

o If the line is Active license file(s) [MSC_LICENSE_FILE], find the value of the environment
variable MSC_LICENSE_FILE to see what license file Adams is using.

e If Easy5 and Adams are using different licenses (or license servers), set LM_LICENSE_FILE to
the value for the Easy5 license (for example 2500@bosco).

e If Easy5 and Adams are using the same license, your computer is configured properly.

6. For Windows platforms and when using Easy5 2013 or older, modify the Path environment variable
to include the path to the lib_em64t_IF91 subdirectory (64 bit Easy5) or lib_nt_IF91 subdirectory
(32 bit Easy5) of your Easy5 installation tree.

 Ifyour Easy5 (2013 or older) model contains components from a licensed library (for example,
the Thermal-Hydraulic or Gas Dynamics libraries), you will need to make sure Adams finds your
Easy5 license. Failure to perform this step will result in the Easy5 license library not being found.

* The Easy5 model import feature in Adams (Adams importing an Easy5 library) is not supported
with the GNU compiler. If GNU compiler is required, an FMI based interface is recommended
(Adams importing an Easy5 FMU).

To find the appropriate value for the variable:

a. Start Easy5.

b. Open an Easy5 command shell: from the Easy5 File menu, select Open Command Shell.
c. At the command shell prompt, enter: echo %EZHOMED%.

The output is the directory in which Easy5 is installed. You will use the directory information in
Step 5 below. The usual value of EZHOME is:
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C:\Program Files\MSC.Software\Easy5\<version>\

Check hitps:/help.hexagonmi.com/ to find the versions of Easy5 that are compatible
with Adams. Select the current version, for example Adams 2023.1 - Online Help
(HTML) and go to Release Guide -> Supported Versions of Integration Products.

To apply the value of the environment variable:

a.
b.

C.

e

From the Start menu, point to Settings, and then select Control Panel.
In the Control Panel dialog box, select the System icon.

In the System Properties dialog box, select the Advanced tab.

In the Advanced tab container, select Environment Variables.

Adams must know the path to the subdirectory of your Easy5 installation tree to be able to load
ez5_lmgr.dll:

lib_nt_IF91 - For the Intel FORTRAN 10.1compiler.

Using the path from step 3, in the Environment Variables dialog box, append or create the path
to the user variable as follows:

Variable Name = PATH

For the Intel FORTRAN 10.1compiler, enter the following, where <CURRENT_VALUE> is
the current value of PATH:

Variable Value = <CURRENT VALUE>; S$%EZHOMES%\easy5x\lib nt IF91
and where the value of EZHOME is taken into account.


https://help.hexagonmi.com/bundle?name_filter.field=title&name_filter.value=&rpp=10&sort.field=last_uploaded&sort.value=desc
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Installing Adams in Silent Mode (Batch)

By creating a batch setup file, you can automate the process of performing identical installs. You can
customize this file with your preferred settings, put it on a server, and let other users perform their own
installation using the same settings. This section shows you how to create and run the batch file.

To create the batch setup file:

1. From the Start menu, select Run.
2. In the Run dialog box, enter the following:

C:\temp\adams2023_1_windows64.exe -r -f1“c:\temp\mysetup.iss”

W No space between “f1” and “c”.

where:
e C: is the location of your adams_2023_1_windows64.exe file
* fl is a lower-case f and the number 1
o c:\temp\mysetup.iss is the location and name of the batch setup file
3. Select OK.
4. Follow the installation instructions in the section, Installing Adams, 48.

The batch installation file (.iss) is created.

To perform a batch installation:

1. Check the contents of the batch setup (.iss) file to make sure that it contains the correct installation
directory location. For example, if it specifies
D:\Program Files\MSC.Software\Adams\2023_1 as the install directory, and you don’t have a D:
drive, you can change it to C:\Program Files\MSC.Software\Adams\2023_1. See Figure 5-12 on

page 64.

2. Inacommand window, enter the following command:

C:\temp\adams_2023_1_windows64.exe -s -f1“c:\temp\mysetup.iss”

m No space between “f1” and “c”.

where:
e C: is the location of your adams_2023_1_windows64.exe file
* fl is a lower-case f and the number 1

o c:\temp\mysetup.iss is the location and name of the batch setup file.
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[InstallShield Silent]

Version=v7.00

File=Response File

[File Transfer]

OverwrittenReadOnly=NoToAll
[{D6D7D44A-7056-4EAF-9B63-2691B41583DA}-D1gOrder]
D1g0={D6D7D44A-7056-4EAF-9B63-2691B41583DA}-SdWelcome-0
Count=10
D1gl={D6D7D44A-7056-4EAF-9B63-2691B41583DA}-SdCustomerInfo-0
D1g2={D6D7D44A-7056-4EAF-9B63-2691B41583DA}-MSC_SetupType3-0
D1g3={D6D7D44A-7056-4EAF-9B63-2691R41583DA}-SdStartCopy-0
D1g4={D6D7D44A-7056-4EAF-9B63-2691B41583DA}-MSC License-0
D1g5={D6D7D44A-7056-4EAF-9B63-2691B41583DA}-AskOptions-0
D1g6={D6D7D44A-7056-4EAF-9B63-2691R41583DA}-AskOptions-1
D1g7={D6D7D44A-7056-4EAF-9B63-2691B41583DA}-AskOptions-2
D1g8={D6D7D44A-7056-4EAF-9B63-2691B41583DA}-AskOptions-3
D1g9={D6D7D44A-7056-4EAF-9B63-2691B41583DA}-SdFinish-0
[{D6D7D44A-7056-4EAF-9B63-2691B41583DA}-SdWelcome-0]
Result=1
[{D6D7D44A-7056-4EAF-9B63-2691B41583DA}-SdCustomerInfo-0]
szName=buildadm

szCompany=MSC Software Corporation

nvUser=1

Result=1
[{D6D7D44A-7056-4EAF-9B63-2691B41583DA}-MSC SetupType3-0]
szDir=C:\Program Files\MSC.Software\Adams\2023 1

Result=301
SetupType=501
SetupName=Full
[{D6D7D44A-7056-4EAF-9B63-2691B41583DA}-SdStartCopy-0]
Result=1

[Application]

Name=Adams

Version=18.1.0

Company=MSC Software Corporation

Lang=0009
[{D6D7D44A-7056-4EAF-9B63-2691B41583DA}-MSC_License-0]
SzEdltlﬁ27500@yoda ‘ License server
Result=1
[{D6D7D44A-7056-4EAF-9B63-2691B41583DA}-AskOptions-0]
Result=1

Sel-0=1

Sel-1=0
[{D6D7D44A-7056-4EAF-9B63-2691B41583DA}-AskOptions-1]
Result=1

Sel-0=1

Sel-1=1
Sel-2=1

Figure 5-12 Sample setup.iss file

Installation Directory
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Overview
Adams products use a license server to manage the access to its products. Therefore, before you can run the
products you just installed, you must license them. The next sections explain more about Adams licensing,
the initial licensing options, and how you can manage the licensing after you’ve initially licensed the products.
m Licensing Basics, 67
m Specifying your License, 68
m Replacing Codes (Licenses) on an Existing Windows Server, 69
m Customizing End-User License Administration, 70
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Licensing Basics
You can license Adams products in the following ways:

m Set up a license server that is available to your users through the network, and set up the number of
users who can use Adams. The number of users who can run Adams concurrently depends on the
number of licenses you purchased. Refer to your password certificate for information on the number
of users who can run Adams.

You can run the license server on one machine or on three. We strongly recommend that you use a
one-server configuration, however. If you select a three-server configuration, the machines act as
backups to the other machines. You must install passwords on all of the server machines to set up a
three-server configuration.

You can select to load only the licensing tools on the license server and install the Adams products
only on the clients.

You also can set up the licensing so that it is locked to a particular machine or node. If your Adams
licensing is node-locked, then users can only run Adams products on that machine. To see if you
have purchased node-locked licensing, refer to your password certificate.

m Set up a client using an existing license server.

In both cases, the procedure for licensing Adams is the same.
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Specifying your License

You typically specify the license for Adams during the installation procedure (see Step 13. on page 55).
However, you can modify the license type, location, or name at any time following the installation.

If you already installed Adams on your network and have a license server running, you can enter the hostname
and TCP/IP port number of the license server to run Adams from that license server.

For Adams installations, the TPC/IP port number defaults to 27500 and is in the following format, where
hostname is the name of the host:
27500@hostname

If you do not know the name of the host, enter the command hostname at a command prompt. Or, you can
refer to the SERVER line of your password certificate/license file.

To specify or modify Adams licensing:

1. From the Start menu, point to Programs, point to Adams 2023.1, and then select Settings &
License.

2. Select Licensing.
3. In the licenseFile field enter the name of the license server or the path to your license file.

4. Select OK.
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Replacing Codes (Licenses) on an Existing Windows
Server

Follow these steps if you have an existing Adams installation and have received new codes (as a renewal,
change, and so on).

To update your passwords:

1. Place the new codes as a license file in the same directory as the existing license.dat file. Name it
license_new.dat. Change the SERVER and DAEMON lines in the new license file to include the

same port number, server name, and paths as the existing file. For example:
SERVER serverl 123465 27500

DAEMON MSC c:\Program Files\MSC.Software\MSC.Licensing\ XX.x\MSC.exe
Where XX.x is a current version. For example:

c:\Program Files\MSC.Software\MSC.Licensing\/1. 13\MD.exe.

2. Use Windows Explorer to rename the existing license.dat file to license_old.dat, and the new file to
the current license file name (license.dat).

3. Run Imtools.exe, and then select Config Services.

4. Select the appropriate license server in the box below (if you have more than one).
5. Select the Start/Stop/Reread tab.

6. Select ReRead License File.

This should re-read the license.dat file and enable your new licenses. If there is a problem, or if the licenses
are still not available, restart the system.
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Customizing End-User License Administration

You can use the daemon options file provided with the license manager to customize the installation. This
option file allows the end-user to:

m Reserve licenses for specified users or groups of users.
m Restrict the use of the software to certain people.
= Set software time-outs.

m Log activity for use with an optional report writer.
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Starting Adams Products

This sections described how you can start your Adams products on Linux and on Windows.

Starting Adams Products on Linux

The Adams Toolbar is a starting point to using Adams products on Linux. The toolbar is shown below.

Adams Toolbar tool - Right click to set up Toolbar, manage
memory models, access online help and Technical Support
resources and more

Product tools - Click to run product or right-click to configure
products and create user libraries.

Hold the cursor over a tool to see the name of the associated product.

Figure 7-1 Adams Toolbar

You can also use the Adams Toolbar to:
m Customize, keep track of, and organize multiple libraries of standard Adams products
m Create binaries
® Manage custom memory models and product preferences

For more information on these or other Adams Toolbar operations, see the Running and Configuring online
help (from the Help menu in any product, select Adams Help, near the top of the pane on the left, select
Configuring Adams).

To start a product on Linux:

1. To display the Adams Toolbar, at the command prompt, enter the command adamsx where x is the
version number, for example adams2023_1.

2. Click on the tool representing the product you want to start.
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We recommend that you use the Adams Toolbar to start your Adams products, but
if you want to automate certain operations, use the text-based Program Menu. For
more information, see the Running and Configuring online help.

Remote access tools to Linux machine

X terminal is a display/input terminal for X Window System client applications.
Many X terminal tools are available to display X client applications on remote
Windows machines. Running Adams with such tools doesn’t guarantee a good
graphics experience for remote Linux OS machines. Hexagon recommends the use
of NoMachine for the best chance of mitigating these issues.

Starting Adams Products on Windows

You start any Adams product from the Start menu. You can also use the Start menu to:
m Change your license type
m Generate problem reports

m Set Adams preferences

For more information on these or other operations, see the Running and Configuring online help.

To start a product on Windows:

® From the Start menu, point to Programs, point to Adams 2023.1, point to the name of the product
you want to start.

Adams start up command has been changed from "adams2023_1_x64" to
"adams2023_1". The "MSC.Software" folder from Start "All Programs" has been
dropped."

Tip: Select the corresponding desktop icon for the product, if you installed it on your
desktop.

To start a product from DOS shell in Windows:
m Start = Programs — Adams 2023.1 = Command Prompt.

® An alternative is to add the /bin directory under the Adams installation directory to your user
PATH environment variable. You can do this via the Control Panel:
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Starting Adams Products

a. Type environment in the Control Panel search box.

b. Select the Edit environment variables for your account pick.

@Q;|@ » Control Panel » v|4'-f| environment 1 x |

By System
. |Edit environment variables for your account I 2
B Edit the system environment variables

I@ISearch Windows Help and Support for "environment”

_J

Figure 7-2 Navigation to Edit Environment Variables

Check to see if you already have a PATH variable defined under “User variables”. If it exists then
edit it, add a semicolon “;” to the end of the existing value, and then add the “bin” directory under
the Adams installation directory. Otherwise select New..., use PATH for the variable name and add
the “bin” directory under the Adams installation directory as the value. The default location of this
directory is:

C:\Program Files\MSC.Software\Adams\2023 1 XXXXXX\bin

(where XXXXXX denotes the build number)

Once you are done click OK.

Windows appends your User PATH to the System PATH environment variable, so there is
no need to copy the existing System PATH variable to your user PATH variable. This
behavior is unique to the User PATH variable. For all other environment variables, a User
variables definition overrides a System Variables definition.
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Environment Variables

User variables for mcoll

Variable

OneDrive

Value
Ch\Users\mcoll\OneDrive

C\Program Files\MSC.Software\Adams\2023_X_ XXXXXX
C\Users\mcoll\AppData\Local\Temp
C\Users\mcoll\AppData\Local\Temp

System variables

New... Edit... Delete

Variable

ComSpec
HummPATH13
I_MPI_ROOT
IFORT_COMPILER1Y
INSPECTOR_2017_DIR
INTEL_DEV_REDIST
INTEL_LICENSE_FILE

Value

CAWINDOWS\system32\cmd.exe

C\Program Files (x86)\Hummingbird\Connectivity\13.00\Acc...
C\Program Files (x86)\IntelSWTools\compilers_and_libraries._...
C\Program Files (x86)\IntelSWTools\compilers_and_libraries._...
CA\Program Files (x86)\IntelSWTools\Inspector 2017\
C\Program Files (x86)\Common Files\Intel\Shared Libraries\
C\Program Files (x86)\Commaon Files\Intel\Licenses

New... Edit... Delete

Figure 7-3 Editing Environment Variables
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Setting Preferences

This section describes how you can set preferences, such as your working directory, graphics setting, and
memory model size.

Setting Preferences on Linux

You use the Adams Registry Editor from the Adams Toolbar to set a variety of preferences. For information
on the preferences you can set, see the Running and Configuring online help.

To display the Registry Editor:
® From the Adams Toolbar, right-click any product tool, and then select Change <Product Name>
Settings.

Setting Preferences on Windows
You use the Settings menu to modify:

m Graphics settings

m Licensing

® Memory model size

To display the Settings dialog box:
® From the Start menu, point to Programs, point to Adams 2023.1, and then select Settings &
License.
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Setting Your Working Directory

During a session in a default or custom product, you can select the directory where you want to place your
model and output files.

For Adams View, you can set the working directory from the Welcome dialog box.

To set your working directory:

1. From the File menu, select Select Directory.

2. In the dialog box that appears, select the working directory.
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Using Distributed Computing for Nonlinear Adams Flex
Bodies

Overview

When constructing a model containing nonlinear flexible bodies using Adams MaxFlex the model can be
configure to distribute the computing effort across multiple hosts by specifying Compute Resource
hostnames for the nonlinear flex bodies. A prerequisite for a simulation utilizing Compute Resource hosts is
that those hosts have been properly configured.

Before an Adams simulation is able to utilize distributed computing some network daemons must be started.
On a host on the local network a process called a Directory Service Server needs to be running. In addition,
a process called a Starter Daemon needs to be running on each compute host. When needed the Starter
Daemon process on a compute host will start one or more NLFE services. The figure below shows a diagram
of the relationship between Adams Solver, the network daemons, and the NLFE service.

Directory Service #--—--ceceaaad Starter Daemon
4 P 4
1 -~ |
: :
: o :
| » |
\ A’ \ 4
Adams « » NLFE Service
Figure 7-4 Adams Solver, Network Deamons and NLFE service links

The Directory Service runs in a thread inside client kernel and is listening. This functions as a broker between
the Adams Solver process and the Starter Daemon on an external host. The Starter Daemon registers itself
with the Directory Service when it starts. The Directory Service keeps a list of registered hosts along with
their credentials. Later when Solver is connecting to an external host it starts by contacting the Directory
Service to obtain the host's credentials. The Directory Service runs automatically when required.

The Starter Daemon is a process that, when requested, starts up instances of services installed on a remote
host. Adams utilizes the Starter Daemon to start the NLEE service when required. A running Starter Daemon
is needed on each host that an Adams model utilizes. Only one Starter Daemon should be run on any given
host.
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Adams- NLFE Client Manager

The Adams NLFE Client Manager is a tool used to start and stop the Starter Daemon on a host.

|® ' Adams NLFE Client Manager = O X

Adams NLFE Client Manager

Starter Daemon IP Address 172.16.143.154 -

Starter Dasmon Port Number |41mn > 34000

Working Directory | | =

Log File Directory | ||i""

Start Starter Daemon

Stop Starter Deemon

Figure 7-5 Adams NLFE Client Manager Dialog Box
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Starting Adams - NLFE Client Manager

On Windows start the Client Manager from the Windows menu:

B Adams 20231
Adams Car
Adams Co-simulation
Adams Dniveline
Adams Flex
Adams Insight
Adams PostProcessor
Adams Solver
Adams View
Command Prompt
NLFE Client Manager
Online Help

Settings & License

' Troubleshooting Report

Figure 7-6 Starting Adams - NLFE Client Manager

%: adams<version> —clientmanager

Where, <version> is replaced with the actual string of the version of Adams installation, that is, 2023_1.
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Starting a Starter Daemon

Start a Starter Daemon by logging onto the host where the demon is to run and starting the Adams NLFE
Client Manager. Then specify a Starter Daemon IP Address, Port Number, enter or browse for a Working
Directory, enter or browse for a Log Directory, and then push the "Start Starter Daemon" button. After a
few seconds the Start Starter Daemon button will become grayed out and the Stop Starter Daemon button
becomes enabled. For best performance, the Working Directory should be on a fast physical drive on the host
machine. IP Address is set automatically but you may need to change it if it's not suitable when the machine
has multiple addresses. The default of the Working Directory is the current directory and the Log Directory
is the Working Directory. The process name for the Starter Daemon is SDServer. After you have started the
daemon close the Client Manager.

B ' Adams NLFE Client Manager - O *

Adams NLFE Client Manager

Starter Daemon 1P Address 172.16.143.154 v

Starter Daemon Port Number 40000 > 34000

Working Directory

¥

Log File Directory

T8

Start Starter Daemon

Stop Starter Deemon

Figure 7-7 NLFE Client Manager: Start and Stop Starter Daemon
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IP Address and Port Number of Directory Service and Starter Daemon

IP Address and Port Number have to be defined correctly for the communication between Directory Service
and Starter Daemon. The IP Address field is a pulldown menu of valid IP addresses. IP Address is set
automatically on both services and Port Numbers of Directory Service and Starter Daemon are set to 45000
and 40000 as default, respectively. If the machine has multiple addresses and the IP Address is not suitable or
the Port Number is busy, both can be changed as follows.

m Directory Service (Adams platform)

Set the environment variables in ACF file, MSC_ADAMS_NLFE_SET_DSADDR and
MSC_ADAMS_NLFE_SET_DSPORT respectively. The applied values can be shown as
DS_ADDR and DS_PORT in DSC.xml file that is exported in the current directory during the

analysis.
m Starter Daemon (NLFE platform)

Change the values using the NLFE Client Manager. One needs to stop the daemon first, change the
values and then start again. When the Port Number is changed (to something other than the default
of 40000), it's required to specify the number via the COMPUTE_RESOURCE option in a
FLEX_BODY statement, for example:

FLEX_BODY/5

, MATRICES =1, 2, 3, 4

, BDF FILE = sample.dat

, COMPUTE_RESORCE =|linux_box:42000

Add a colon (":") between the machine name and the Port Number as shown above.
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High Performance Computing Considerations

Intel® SpeedStep for Windows 10

For computers running Windows 10 we have found Intel's SpeedStep to be enabled by default. Furthermore,
we have mixed results in Adams Solver performance in our testing of the SpeedStep setting. Some models
run slightly faster, but other models run slightly slower when SpeedStep is enabled versus disabled. Thus, we
cannot make a recommendation for SpeedStep setting on Windows 10. We suggest keeping the default
(Enable) unless you have another reason to disable it. In which case, depending on the model you may only
see a slight increase or decrease in Solver performance.

When SpeedStep is enabled, another setting called Minimum Process State is available in Processor Power
Management. In our testing we have found that between 5% (default setting for Balanced Power
Management) and 100% (default setting for High Performance), there is essentially no difference in Adams
speed.

Intel® Hyper-Threading Technology

Intel processors provide a logical setting for hyper-threading technology (HT'T) that can use physical CPU
resources more efficiently. Logical processors are the number of physical cores times the number of threads
that can run on each core through the use of HTT. Currently, HT'T supports two threads per core, so on a
4-core processor, one can have 8 logical processors with HTT activated.

Adams and even the operating system does not provide an option to control the setting of HT'T. This can
only be done in the BIOS. Most of not all modern systems that employ an Intel logical processor has this
setting activated by default.

In our testing it has been found that Adams simulation speeds may improve up to 20% with HTT turned
OFF due to the additional logical overhead in HT'T. Thus, for Adams performance, it is recommended to

have HTT turned OFF in general. One can view the current setting of HTT using the Iscpu command on
Linux, or from the Windows Task Manager.



Linux Administration and
Configuration

B Overview
B Setting Up the Client Machine

B pdating Passwords
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Overview

This chapter describes some basic administration and configuration operations you might want to perform
after you install the Adams products, and others that you might need to perform periodically as you obtain
new passwords. These operations include the following:

m Setting Up the Client Machine, 87
m Updating Passwords, 88
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Setting Up the Client Machine

If you did not install the Adams software as root, you need to make Adams available to all the users by
creating a link from a user directory to the installation directory.

To set up a client machine:
1. Mount the Adams installation directory from the central file server to each machine that is going to
run Adams.
2. Cireate a startup command on each user’s machine in the directory of your choice, using the
commands:

In -s /install dir/mdi adams2023 1

This link must be created in a directory that is in the user’s path. Check the Path environment
variable to see the directories that are already in the user’s path.
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Updating Passwords

If you receive new passwords from Hexagon, follow the instructions below to update your passwords. If you
receive new software along with the passwords, you should follow the complete installation instructions in
Installing Adams on Linux, 19

m If the license server started with root, you must be root to stop and start it.

The following are two ways to update your passwords:

m Using the Adams Installation Script, 88
m Updating Outside the Installation Script, 88

Using the Adams Installation Script

To update passwords using the installation script:

1. Log on to the Adams license server.

Move to Adams installation directory.

Start the installation program INSTALL.ADAMS.

At the prompt, enter 3 to select the option, Stop the Adams license server(s).

At the prompt, enter 1to select the option, Install Adams passwords on this license server.

Enter the new passwords by entering the name of the file containing the passwords.

N s B

At the prompt, enter 2to select the option, Start the Adams license server on this machine.

Updating Outside the Installation Script

To update passwords outside the installation script:

1. Place the new codes as a license file in the same directory as the existing license.dat file. Name it
license_new.dat. Change the SERVER and DAEMON lines in the new license file to include the
same port number, server name, and paths as the existing file. For example:

SERVER serverl 123465 27500
DAEMON MSC /msc/flexlm/bin/md

2. Rename the existing license.dat file to license_old.dat, and rename the new file to the current license
file name (license.dat):

# mv license.dat license_old.dat
# mv license_new.dat license.dat
3. Use the Imreread command to force the Imgrd daemon to reset using the new license file.

# flexim_install_dir/lmreread -c <path>/license.dat
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where flexIm install diris the directory where FLEXIm is installed.

m If you do not have an Imreread executable, copy Imdown and name it Imreread

You should now be able to run Adams products using the new licenses. If this fails, kill and restart the
daemons as follows:

# flexim_install_dir/lmdown -c <path>/license.dat
# flexim_install_dir/lmgrd -c <path>/license.dat



Troubleshooting

B Qverview
B Troubleshooting on Windows

B Troubleshooting on Linux
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Overview

This chapter describes how to generate problem reports to send to Adams Technical Support. Italso lists some
common problems that can occur when installing, updating, and running Adams software, and recommends
solutions to those problems.

m Troubleshooting on Windows, 93
m Troubleshooting on Linux, 96

If you do not find your problem in this chapter or if the recommended solution does not solve your problem,
then:

m Refer to the Adams Technical Articles at http://simcompanion.hexagon.com
m Contact Adams Technical Support as explained in Getting Help, 7.


https://simcompanion.hexagon.com/customers/s/
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Troubleshooting on Windows

Generating Problem Reports

You can generate a report that examines your system configuration and places important debugging
information in the file adams_problem_report.txt. If you have problems running Adams, you can generate this
report and review it or send it to Adams Technical Support by fax or e-mail. As you review the report, refer
to the sections in this chapter for explanations of many of the error messages that appear in the report.

For correct results, you must run the problem report from the license server, not the client
machine.

To generate and review a report:

1. From the Start menu, point to Programs, point to Adams 2023.1, and then select Troubleshooting
Report.

Adams creates a problem report in your home directory.

2. To review the report, open it into a text editor, such as Notepad.

Obtaining New Passwords
If you need new passwords, you can obtain them by calling your Hexagon Sales Administrator.
When requesting new passwords, provide the following information:

® Request number and 